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Walk-Through

Candy Packaging
Your client, a candy manufacturer, 

has hired you to design and build the 

packaging for a new product launch 

at its anniversary party, which will 

be held at the annual candy expo. 

You will incorporate client-supplied 

elements and create custom graphics 

as you develop an attractive, modern 

box design. 

This project incorporates the following skills:

o Using Image Trace to create a complex illustration

o Sampling colors to create custom swatches

o Using warp and 3D effects to add depth to artwork

o Creating type on an irregular path 

o Controlling object blending modes and opacity

o Understanding and defining raster effect settings

o Previewing 3D artwork
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Project Meeting
We’re celebrating our company’s 75th 
anniversary this year. For the annual candy 
expo, were introducing SmartTarts™ — a new 
product that combines di� erent � avor pro� les 
and textures into a single candy. Response at 
early focus groups has been very positive, so 
we’re excited about the potential.

We would like to create a fun, colorful box 
to hand out product samples at our reception 
following the � rst day of the show. We’d like 
to give a larger sample size to the VIP guests 
who are invited to the party, so we need a box 
that is a 4-inch cube. Later we’ll need to create 
a smaller box that we can use for show-� oor 
samples, as well as � nal packaging that will be 
used for the retail product.

We have a template from the printer with the 
package structure already laid out, based on an 
existing die that’s used to cut the � at box from 
the press sheet. � ere’s no need to reinvent the 
wheel, so use this template to build the � nished 
box artwork. 

� e only thing they said they want is “fun, 
colorful” packaging, so we have complete 
artistic freedom for this project. � ey did send 
some components that need to be included: a 
background image, an anniversary logo, and 
some copy. � ey didn’t send a company logo, 
so I think we’ll try something creative with 
their company name.

Illustrator has all the tools you need to 
make this package technically accurate and 
aesthetically pleasing. When you � nish the 
layout, you can even use built-in tools to create 
a comp of the � nal folded box.

To complete this project, you will:

❏ Create the package � le from a template

� Sample colors to create custom swatches

� Create warp and 3D e� ects

� Create type on an irregular path 

� Change object blending modes and opacity

� Apply raster e� ects to vector objects and 
placed images

� Apply e� ects to pieces of a group

� De� ne raster e� ect settings

� Preview transparency � attening

� Flatten transparency in a PDF � le 

� Preview a 3D representation of the 
completed box artwork
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Stage 1	 Building	the	File	Structure

When you work on a package design, it’s important to realize that many types of packages have a 

standard size and shape. Although there is something to be said for standing out in a crowd, packaging 

design is often governed by the space allowed on store shelves — which means you probably won’t 

have any choice regarding the size and shape of the package. 

You also need to understand that packages are typically designed and printed as a flat layout, using 

a template to indicate edges and folds; they are then die-cut, folded, and glued. The next time you 

finish a box of crackers or cereal, tear it apart along the glue flaps to see how the package was designed. 

Because these types of packages are common sizes, printers often have existing templates you can use.

Create the PaCkage File From a temPlate

The printer for this package has provided you with a template file that includes the die-

cut layout and folding guides. You will use this file as the basis for the entire project.

 1. Download AICC_RF_Projec
t6.zip from the Student Files Web page.

 2. Expand the ZIP archive in your WIP folder (Macintosh) or copy the archive 

contents into your WIP folder (Windows).

This results in a folder named Candy, which contains the files you need for this project. 

You should also use this folder to save the files you create in this project.

 3. Create a new file by opening the square-box.ait template file from your 

WIP>Candy folder. Resize the view so you can see the entire artboard.

The file has three layers: one has guides indicating the location of the folds, one has 

guides that define margin and bleed areas for each panel, and one has the die lines for the 

box shape. 

The box’s top and bottom panels are identified, as well as the flap where glue will be 

applied in the converting process to create the finished box shape. You should notice that 

the red bleed guide does not extend to the end of the glue flap; the printer for this job has 

recommended that ink should not be printed in the gluing area (a common requirement 

for package printing). 

 4. Save the new file as a native Illustrator file named candy-box.ai in
 your 

WIP>Candy folder, then continue to the next exercise.

305Project 6: Candy Packaging

Create type on a path

Instead of simply flowing text into a type object, you can create unique typographic 
effects by flowing text onto a path. A text path can be any shape you can create in 
Illustrator, whether it’s a simple shape created with one of the basic shape tools, a 
straight line drawn with the Line Segment tool, or a complex graphic drawn with  
the Pen tool.

 1. With candy-box.ai open, lock the groups on the Side 1 and Side 2 layers.

You can use the Lock icon for individual sublayers to lock those objects without locking 
entire layers.

 2. With the Side 1 layer active, choose the Pen tool. Change the fill to None 
and the stroke to 1-pt black. 

 3. Draw a curve above the banner shape, extending across both panels 
(as shown in the following image).

 4. With the path selected, double-click the Eraser tool in the Tools panel.

The Eraser tool erases parts of a shape, whether from an open or closed path. When you 
use this tool, Illustrator automatically adds anchor points as necessary based on what 
you erase.

 5. In the resulting dialog box, change the Size field to 8 pt, then click OK.

You can also use this dialog box to change the angle and roundness (shape) of the Eraser 
tool cursor.

Eraser 
tool

 6. Place the cursor over the panel fold line between the first and second panels.

The tool cursor 
indicates the 
brush size.

The Eraser tool erases 
from the fill and stroke 
of the object. The Path 
Eraser tool only erases 
from the selected path; an 
object’s fill is not affected.

Note:

Project Goals
Each project begins with a clear description 
of the overall concepts that are explained 
in the project; these goals closely match the 
different “stages” of the project workfl ow.

The Project Meeting
Each project includes the client’s initial 
comments, which provide valuable 
information about the job. The Project 
Art Director, a vital part of any design 
workfl ow, also provides fundamental 
advice and production requirements. 

Project Objectives
Each Project Meeting includes a 
summary of the specifi c skills required 
to complete the project.

Step-By-Step Exercises
Every stage of the workfl ow is 
broken into multiple hands-on, 
step-by-step exercises.

Visual Explanations
Wherever possible, screen shots 
are annotated so that you 
can quickly identify important 
information.

Real-World Workfl ow 
Projects are broken into logical lessons or 
“stages” of the workfl ow. Brief introductions at 
the beginning of each stage provide vital foun-
dational material required to complete the task.
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Project 6: Candy Packaging

Project Review

 1. Briefl y explain how the concept of a diecut relates to package design in Illustrator.

 2. Briefl y explain the concept of sublayers, including at least one example of their potential benefi t.

 3. Briefl y explain how transparency settings relate to Illustrator fi les created for commercial printing.

 1. You can use the _______________ tool to 

sample colors from placed images.

 2. The _______________ can be used to review all 

the available characters in a font.

 3. Checking the _______________ option 

when you place a native Photoshop fi le results 

in a single object on a single layer in the 

Illustrator fi le.

 4. The _______________ determines the left-

indent position of type on a path.

 5. You can use the _______________ panel to 

review and edit applied effects.

 6. Applying a _______________ to an object 

forces surrounding text to fl ow around 

that object instead of directly in front of 

or behind it.

 7. The _______________ is the specifi c method 

used to blend the color of one object into the 

colors of underlying objects.

 8. _______________ refers to the degree to which 

light passes through an object.

 9. A(n) _______________ can be used to restrict 

opacity to selected objects; colors in the 

topmost object determine which areas of the 

underlying object are visible.

 10. The _______________ tool can be used to 

cut apart an overall composition into pieces, 

generating individual images from the pieces 

you defi ne.
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Use what you learned in this project to complete the following freeform exercise. 
Carefully read the art director and client comments, then create your own design to meet the needs of the project.
Use the space below to sketch ideas; when fi nished, write a brief explanation of your reasoning behind your fi nal design.

Portfolio Builder Project

� e new game is a typical action-adventure game 
with a historical context. � e goal is to the navigate 
a labyrinth inside one of the pyramids to � nd the 
Pharaoh’s treasure without being captured by the 
various beasties that protect the hidden chamber.

One side panel needs to list system requirements 
for the game. We know it will work on most game 
systems, but we’re still trying to work out the bugs 
on the latest releases, so we haven’t � nalized that in-
formation yet. For now, use placeholder bullets that 
say something like ‘requirement listing.’ � at way 
we can see the formatting even though the actual 
text isn’t ready yet. 

� e back of the box will incorporate some screen 
captures, which we’ll provide as soon as the devel-
opment is � nalized. For now, just leave placehold-
ers to mark the space where those will be placed.

Finally, make sure you build a space on either the 
back or one side of the box for a bar code.

Your agency has been hired to develop 
packaging for a new video game called 
Eye of Horus, which is an adventure game set 
in Egypt when the pyramids were being built.

To complete this project, you should:

❏ Disassemble (� atten) an existing game box 
and measure the di� erent elements. Create 
a diecut template in Illustrator using those 
measurements.

� Design box artwork for the new video game 
using images or creating illustrations that 
support the general theme of the product. 

� Incorporate the product name on all sides 
of the box. 

Project Summary
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� e � exible artboard size and layer controls, coupled with the extensive set of creative tools, make 

Illustrator ideally suited to meet the complex needs of packaging design. You can design sophisticated 

artwork that can be wrapped or folded into virtually any shape to package virtually any product.

� is project combined the technical requirements of packaging design — speci� cally using a 

custom diecut template supplied by the output provider — with the artistic capabilities necessary to 

create the � nal design for a custom candy package. You composited a number of existing elements 

and created others, then used a number of features to modify artwork — adding interest and depth to 

unify the di� erent pieces into a single, cohesive design.

Use Image Trace to create a complex illustration from photographic elements

Use the Touch Type tool to manually edit character size and position

Apply multiple 
effects using a 
built-in graphic style

Change blending 
modes to create 
subtle color variations

Use transparency to unify artwork components

Create artwork to fit 
a printer-supplied 
die-cut template

Create type on 
a custom path

Apply and control 
text wrap settings

Use effects to create depth and add visual 
interest 

Slice a file to create separate component elements

Prepare a 3D sample for client approval

324 Project 6: Candy Packaging

Expanding Appearance Attributes

When you print a fi le, the raster-image processor (RIP) 

processes the  PostScript stream to create the print. 

Extremely complex designs can take a long time to output, 

depending on the processing capability of the output device, 

and can even “jam the RIP” — crash the device and cause 

an output error. To prevent output problems associated 

with overly complex designs, you might want to expand 

appearance attributes after the design has been fi nalized. 

If you select an object and choose Object>Expand 

Appearance, the object is permanently altered to mimic the 

appearance of the previously applied effects. Applied raster 

effects are converted to the necessary raster objects, which 

are grouped with the converted vector objects. 

After expanding effects, the fi le will output faster, but you 

won’t be able to change the effect settings. We highly 

recommend saving the original and expanded versions as  

separate fi les so you can make changes if necessary.

The paths show the new objects created by expanding 

the effects. The effects are no longer editable.

Two effects have been applied to this object: 

Warp (Arch) and 3D Extrude & Bevel. 

Flattening Individual Objects

Although fl attening is typically managed for you when you 

output a fi le, you can fl atten selected objects manually 

at any point in the process. Like expanding an object’s 

appearance, fl attening is a permanent action — you 

can no longer edit any effect or setting that caused the 

transparency. This process should only be done at the very 

end of a project; again, we recommend maintaining your 

original fi le and saving a new version with the manually 

fl attened artwork.

When a transparent object is selected, you can choose  

Object> Flatten Transparency to defi ne settings that will be 

used to create the necessary raster object. 

Flattening the object created a new raster object to 

reproduce the Drop Shadow effect. (If Preserve Alpha 

Transparency is not checked, the fl attened artwork will 

have a white background; the effect will not blend into the 

background color.)

Understanding Flattener Presets

Illustrator includes four default  fl attener presets. You can also choose 

Edit>Transparency Flattener Presets to create your own presets or load 

presets that might be provided by other users — such as one your 

service provider created for their specifi c workfl ow.

•  Raster/Vector Balance determines how much vector information 

will be preserved when artwork is fl attened, from 0 (all information 

will be fl attened as rasters) to 100 (maintains all vector information). 

•  Line Art and Text Resolution defi nes the resulting  resolution of 

vector elements that will be rasterized, up to 9600 ppi.  

•  Gradient and Mesh Resolution defi nes the resolution for gradients that will be rasterized, up to 1200 ppi. 

•  Convert All Text to Outlines converts all type to outlines; the text will not be editable or selectable in a PDF fi le. 

•  Convert All Strokes to Outlines converts all strokes to fi lled paths.

•  Clip Complex Regions forces boundaries between vector objects and rasterized artwork to fall along object paths, 

reducing potential problems that can result when only part of an object is rasterized. 

•  Anti-Alias Rasters helps to create smoother edges in the raster images that are created from vector graphics.
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More About Outputting Complex Files
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 3. Click the preview icon and drag it around.

As you drag the preview cube, the values in the three fields change, based on how and 
where you drag. In the layout, the selected group also changes because the Preview 
option is active.

X Axis

Y Axis

Z Axis

Preview cube

While you move the preview icon, 
the object appears as a wire frame 

(the basis of 3D artwork).

 4. When you’re done experimenting with the preview, specify the following values: 

X Axis = 20° 

Y Axis = 0°  

Z Axis = 0°

Extrude Depth = 50 pt

 5. Click OK to apply the effect.

 6. Select the banner group on Panel 2, then choose Effect>Apply Extrude & Bevel.

The top menu option shows the last-used effect. If you use this menu command, the 
effect will be applied with the last-used settings. You will not see the effect’s dialog box. 

   

 7. Using the Arrow keys, nudge the second banner group up or down until the 
two objects align to each other.

The Extrude & Bevel effect can slightly shift objects on the artboard. To restore the 
appearance of a single banner extending across both box panels, you have to nudge the 
extruded banners back into the correct position.

 8. Save the file and continue to the next exercise.

Illustrator remembers the 
last-used effect, and the 
specific settings you used 
to apply that effect. The 
top of the Effect menu 
includes the option to 
apply the last-used effect 
without opening the 
related dialog box, or to 
open the dialog box for 
the last-used effect. 

Note:

The surface of the object 
only appears after the 
wires are calculated 
internally.

Note:

Illustrator Foundations
Additional functionality, related tools,  
and underlying graphic design concepts  
are included throughout the book.

Advice and Warnings
Where appropriate, sidebars  
provide shortcuts, warnings, or 
tips about the topic at hand.

Visual Summary
Using an annotated version of the 

finished project, you can quickly  
identify the skills used to complete 

different aspects of the job.

Project Review
After completing each project, you  
can complete these fill-in-the-blank and 
short-answer questions to test your under-
standing of the concepts in the project.

Portfolio Builder Projects
Each step-by-step project is accompanied 
by a freeform project, allowing you to 
practice skills and creativity, resulting in an 
extensive and diverse portfolio of work.
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Identity Package

o Working with Gradient Meshes

o Working with Type 

o Working with 
Multiple Artboards

o Combining Text 
and Graphics
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 2 Balloon Festival Artwork

o Drawing Complex 
Artwork

o Coloring and 
Painting Artwork

o Exporting EPS 
and PDF Files
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 1 International Symbols

o Setting up the Workspace

o Drawing Basic Shapes

Th e Against Th e Clock Portfolio Series teaches graphic 
design software tools and techniques entirely within 
the framework of real-world projects; we introduce and 
explain skills where they would naturally fall into a real 
project workfl ow. 

Th e project-based approach in Th e Professional 
Portfolio Series allows you to get in depth with the 
software beginning in Project 1 — you don’t have to read 
several chapters of introductory material before you can 
start creating fi nished artwork. 

Our approach also prevents “topic tedium” — in 
other words, we don’t require you to read pages and 
pages of information about text (for example); instead, 
we explain text tools and options as part of larger project 
(e.g., creating a logotype or building a folding brochure). 

Clear, easy-to-read, step-by-step instructions walk 
you through every phase of each job, from creating a new 
fi le to saving the fi nished piece. Wherever logical, we also 
off er practical advice and tips about underlying concepts 
and graphic design practices that will benefi t you as you 
enter the job market.

Th e projects in this book refl ect a range of diff erent 
types of Illustrator jobs, from creating a series of icons to 
designing a corporate identity to building a Web page. 
When you fi nish the eight projects in this book (and 
the accompanying Portfolio Builder exercises), you will 
have a substantial body of work that should impress any 
potential employer.

Th e eight Illustrator projects are described briefl y 
here; more detail is provided in the full table of contents 
(beginning on Page viii).

Projects at a Glance
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Our goal in this book is to familiar ize you with the majority 
of the Illustrator tool set, so you can be more productive and 
more marketable in your career as a graphic designer.

It is important to keep in mind that Illustrator is an 
extremely versatile and powerful application. Th e sheer 
volume of available tools, panels, and features can seem 
intimidating when you fi rst look at the software interface. 
Most of these tools, however, are fairly simple to use with a 
bit of background information and a little practice. 

Wherever necessary, we explain the underlying concepts 
and terms that are required for understanding the software. 
We’re confi dent that these projects provide the practice you 
need to be able to create sophisticated artwork by the end of 
the very fi rst project.
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 7 Consumer Infographics

o Creating Charts 
and Graphs

o Drawing in 
Perspective
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 8 Web Site Interface

o Using Color Groups and Live Color

o Creating Web Site Graphics 
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 6 Candy Packaging

o Building the File Structure

o Working with Styles and Eff ects

o Preparing Artwork for Output 

o Previewing the Box 
Design in 3D
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 5 Letterfold Brochure

o Creating Documents that Fold

o Working with Imported Images 

o Working with Imported Text 

o Fine-Tuning Text
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 4 Ski Resort Map

o Working with Custom Swatches

o Working with Brushes

o Using Symbols
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Getting Started
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 PrereQuisites

Th e Professional Portfolio Series is based on the assumption 
that you have a basic understanding of how to use your 
computer. You should know how to use your mouse to 
point and click, as well as how to drag items around the 
screen. You should be able to resize and arrange win-
dows on your desktop to maximize your available space. 
You should know how to access drop-down menus, and 
understand how check boxes and radio buttons work. It 
also doesn’t hurt to have a good understanding of how 
your operating system organizes fi les and folders, and how 
to navigate your way around them. If you’re familiar with 
these fundamental skills, then you know all that’s necessary 
to use the Portfolio Series. 

resource Files

All of the fi les you need to complete the projects in this 
book — except, of course, the InDesign application fi les — 
are on the Student Files Web page at againsttheclock.com.
See the inside back cover of this book for access 
information.

Each archive (ZIP) fi le is named according to the related 
project (e.g., AICC_RF_Project1.zip). At the begin-
ning of each project, you must download the archive fi le 
for that project and expand that archive to access the 
resource fi les that you need to complete the exercises. 
Detailed instructions for this process are included in the 
Interface chapter.

Files required for the related Portfolio Builder exercises at 
the end of each project are also available on the Student 
Files page; these archives are also named by project (e.g., 
AICC_PB_Project1.zip).

atc Fonts

 You must download and install the ATC fonts from the 
Student Files Web page to ensure that your exercises and 
projects will work as described in the book. Specifi c in-
structions for installing fonts are provided in the documen-
tation that came with your computer. You should replace 
older (pre-2013) ATC fonts with the ones on the Student 
Files Web page.

system reQuirements

Th e Professional Portfolio Series was designed to work on 
both Macintosh or Windows computers; where diff erences 
exist from one platform to another, we include specifi c 
instructions relative to each platform. One issue that 
remains diff erent from Macintosh to Windows is the use of 
diff erent modifi er keys (Control, Shift, etc.) to accomplish 
the same task. When we present key commands, we always 
follow the same Macintosh/Windows format — Macintosh 
keys are listed fi rst, then a slash, followed by the Windows 
key commands. 

Minimum System Requirements for 
Adobe Illustrator CC:
Windows
•  Intel® Pentium® 4 or AMD Athlon® 64 processor
•  Microsoft® Windows® 7 with Service Pack 1 or 

Windows 8
•  1 GB of RAM (3 GB recommended) for 32 bit; 

2 GB of RAM (8 GB recommended) for 64 bit
•  2 GB of available hard-disk space for installation; 

additional free space required during installation (cannot 
install on removable fl ash storage devices)

•  1024768 display (1280800 recommended)
•  Internet connection and registration are necessary for 

required software activation, membership validation, 
and access to online services.*

Mac OS
•  Multicore Intel processor with 64-bit support
•  Mac OS X v10.6.8, v10.7, or v10.8
•  2 GB of RAM (8GB recommended)
•  2 GB of available hard-disk space for installation; 

additional free space required during installation (cannot 
install on a volume that uses a case-sensitive fi le system 
or on removable fl ash storage devices)

•  1024768 display (1280800 recommended)
•  Internet connection and registration are necessary for 

required software activation, membership validation, 
and access to online services.*

* Th is product may integrate with or allow access to certain Adobe 
or third-party hosted online services. Adobe online services, including 
the Adobe Creative Cloud™ service, are available only to users 13 and 
older and require agreement to additional terms and Adobe’s online 
privacy policy. Th e applications and online services are not available 
in all countries or languages, may require user registration, and may 
be subject to change or discontinuation without notice. Additional 
fees or membership charges may apply. 


